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SigmaPlot 11.2.0-Update
Das kostenlose 11.2.0-Update für SigmaPlot 11 enthält zahlreiche Verbesserun-
gen für verschiedene Funktionsbereiche:

Verbesserungen in SigmaPlot 11.2.0:

  SigmaPlot Makro-Bibliothek für Standardkurven, Ligand Binding und ROC-   
 Kurvenmakros; 
  Beispieldateien: Vektorplot und sechs weitere neue Beispiele; 
  Speichern in ältere SigmaPlot-Versionen; 
 Windows-Operationen auf der Graph-Seite: Verbesserungen bei “Alle Fenster     
 schließen” und im Verschieben von Legenden;
 Nutzung der Einweg-ANOVA mit wiederholten Messungen als alternativer Test   
 zum Friedman-Test. Verbesserungen im Falle unregelmäßiger Daten;
 Kolmogorov-Smirnov-Test auf Normalität: Verbesserungen beim p-Wert im Report  
 für die nichtlineare Regression;
	Varianz-Inflationsfaktor	für	logistische	Regression:	Verbesserungen	bei	der	
 Berechnung dieses Wertes;
	Zahleneingabe	in	Zellen,	speziell	bei	der	Eingabe	von	“Undefiniert”-Werten	in		 	
 Zellen;
	Konfidenz-Intervall-Spalten	für	Polynomiale	Regression:	Verbesserungen	bei		 	
 der Beschriftung dieser Spalte;
 Fehlende Werte oder leere Zellen für eine kategoriale Covariate in der 
 Cox-Regression: Verbesserungen beim Report;
 Chi-Quadrat-Test für 2x2-Kontingenz-Tabellen: Verbesserungen in der 
 Yates-Korrektur;
	Cox	schrittweise	Regression:	Verbesserungen	beim	Report,	wenn	es	signifikante
 Covariate im Modell gibt;
 Reports für nichtlineare Regression: Den Reports wurde die Covariate-Matrix 
 hinzugefügt;
 Dunnetts Test für Einweg-ANOVA mit wiederholten Messungen: Verbesserungen  
 im Fall von fehlenden Daten;
 Chi-Quadrat Test-Reports: Verbesserungen im Fall von Zeilen oder Spalten in   
 der Kontingenz-Tabelle, die alle 0 enthalten;
 Ergebnis des Holm-Sidak Mehrfache-Vergleiche-Tests: Leichter zu lesen;
 Bonferroni-Methode zur Berechnung des p-Wertes beim Gruppenvergleich für   
 ANOVA-Interaktionen;
 Einweg-ANOVA mit wiederholten Messungen: Verbesserte Ergebnisse für den   
 Konstante-Varianz-Test;
	User-defined	Transforms:	Verbesserungen	im	Fall	der	Nutzung	der		 	 	
				anwenderdefinierten	Transformationen,	während	der	Regressions-Assistent	
 läuft.
 Quick Transforms: Verbesserte Nutzung der Transformationen als Spaltentitel;
 Plot-Gleichungen, die die abschnittweisen Gleichungen in der Regressions-
 bibliothek einsetzen. 
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SYSTAT 13 ist da!
SYSTAT 13 fügt seinem ohnehin schon umfangreichen Methodenangebot weitere 
statistische Tests wie z.B. ARCH- und GARCH-Modelle für Zeitreihenanalysen hinzu. 
Verbesserungen und Erweiterungen betreffen u.a. die Best-Subset-Regression (BSR), 
die	konfirmatorische	Faktorenanalyse	und	weitere	nicht-parametrische	Test-
algorithmen.

SYSTAT 13 verfügt auch über einen neuen Daten-Editor, der den Einstieg erleichtert 
und	eine	schnellere	Bearbeitung	sichert.	Weitere	Erweiterungen	finden	sich	z.B.	in	
den neuen graphischen Editier-Optionen oder den Updates für die Anwender-
Oberfläche.

In Zusammenarbeit mit Cytel, einem führenden Hersteller für Design- und Analyse-
software im Bereich klinischer Versuche, bietet SYSTAT 13 mit „Exact Tests“ ein 
neues Modul an, das mit dem Exakte-Inferenz-Testverfahren arbeitet.

„SYSTAT 13 hat wieder einen riesigen Schritt vorwärts gemacht, z.B. konnte die 
Geschwindigkeit noch einmal so gesteigert werden, dass Anwender große Datensätze 
jetzt in kürzester Zeit bearbeiten können. Auch SYSTATs Graphiken sind wieder 
beeindruckend und für jede Veröffentlichung oder Präsentation bestens geeignet“, 
erklärt Dr. Leland Wilkinson, Executive Vice President von Systat Software und 
Schöpfer der SYSTAT-Software.

Nähere Informationen unten oder auf www.systat.de/SYSTAT13_Produktseite.html. 
Hier können Sie auch die Upgrade-Broschüre zu SYSTAT 13 sowie ein Bestell-
formular für ihr SYSTAT 12 Upgrade herunterladen.

Informationen zur Installation des SigmaPlot 11.2.0-Upgrades:

  Das Upgrade lässt sich nur installieren, wenn Sie SigmaPlot 11 haben. 

  Zum Downloaden der Datei gehen Sie auf: 
 http://www.systat.de/Transfer/SigmaPlot_11_2_0_Patch.msp. 

  Doppelklicken Sie auf die MSP-Datei. Der Patch wird sich selbst installieren und  
 ersetzt dabei nur solche Dateien, die sich geändert haben. Alle anderen Dateien  
 bleiben unverändert. Bitte nehmen Sie keine Deinstallation der aktuellen Sigma 
 Plot-Version vor. Die Lizenz-Datei wird hier nicht benötigt.

Bitte beachten Sie: Wenn Sie SigmaPlot deinstalliert haben, müssen Sie zuerst 
SigmaPlot 11.0.0 neu installieren, danach den SigmaPlot 11.2.0 Patch.



Prognostizieren Sie die Fehlervarianz bei Zeitreihen 
mit ARCH und GARCH
Konventionelle Zeitreihen- und ökonometrische Modelle 
nehmen an, dass die konditionelle Varianz einer Reihe 
über einen Zeitraum konsistent ist, was jedoch nicht im-
mer der Fall sein muß. ARCH- und GARCH-Modelle be-
nutzen vergangene Unregelmäßigkeiten und Varianzen 
in Ihren Zeitreihendaten, um damit künftige Variationen 
genau zu beschreiben und zu erklären.

Finden Sie die besten Prädiktoren mit der Best-
Subset-Regression (BSR)
Die Best-Subset-Regression versucht, eine kleine Anzahl 
der	besten	Prädiktoren	in	einem	Versuchssatz	zu	identifi-
zieren. Sie ist besonders hilfreich in Situationen, in denen 
evtl. nicht ganz klar ist, welche Prädiktoren am Ende die 
nützlichsten sind, besonders in Bereichen wie Ökonomie, 
Ökologie und Umweltwissenschaften.

SYSTAT 13
Ergebnisse, denen Sie vertrauen, ein Preis, den Sie sich 
leisten können
SYSTAT ist ein umfassendes Desktop Statistik-
Programm, das leicht genug für Einsteiger, dabei 
aber leistungsstark genug für die Ansprüche von 
Experten ist. Das Programm stellt Ihnen ein breites 
Spektrum an komplexen statistischen Methoden 
zur Verfügung – mit robusten Simulations- und 
Scripting-Optionen – und das alles mit einer vari-
ablen	und	anwenderfreundlichen	Oberfläche.

SYSTAT 13 ist schneller, stabiler und robuster 
als seine Vorgänger. Die verbesserte Datenbear-
beitungs-Funktionalität ermöglicht es, mit diesem 
Programm größere Datensätze mit höherer Ge-
schwindigkeit zu bearbeiten, als je zuvor.
 

Sehen Sie, was SYSTAT 13 Ihnen zu bieten hat. 

NOCH MEHR STATISTIK…

SYSTATs herausragende 2D- und 3D-Graphiken sind noch besser geworden, bieten jetzt 
auch verbesserte Detailkontrolle und mehr Farben zur Auswahl, durch die Ihre Präsenta-
tionen und Veröffentlichungen sich besonders hervorheben. 
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•  Der Hypothesen-Test enthält nun auch Tests für Mittel- 
   wert-Vektoren, univariates Bootstrapping und ein neues 
   spaltenbasiertes Eingabe-Layout.
•  Die Polynomiale Regression bietet jetzt auch sehr 
   nützliche und akkurate Vorhersagemodelle für kurvi- 
   lineare Variablen an.
•  Die Liste der nichtparametrischen Methoden wurde  
   erweitert um:
      o  das Jonckheere-Terpstra- und das Flinger-Wolfe-  
 Testverfahren für strukturierte Behandlungsan-  
 wendungen.
     o   neue Mehrfache-Vergleiche-Tests (Dwass-Steel- 
          Critchlow-Flinger, Conover-Inman and Conover).

Geben Sie Ihren Forschungsergebnissen den 
letzten Schliff mit herausragenden 2D- und 3D-
Graphen
SYSTAT 13 überzeugt mit visuell auffallenden, für die 
Publikation perfekt geeigneten 2D-Graphiken und un- 
glaublichen 3D-Graphiken, die Ihren Forschungs-
ergebnissen oder Business-Präsentationen einen 
echten ‚Wow-Effekt’ verleihen.

Erstellen und bearbeiten Sie Graphen mit leichter 
Hand mit SYSTATs Graphik-Werkzeugen
SYSTAT 13 ist vollgepackt mit neuen graphischen 
Editierfunktionen, wie z.B.:

• Reichere Farbauswahl: Bestimmen Sie jede Farbe für 
  Ihre Graphen aus deren Rot-, Grün- und Blau-
  komponenten-Werten.
• Neue Editier-Optionen: Editieren Sie Größe, Farbe, 
  Achsen, Darstellung der Rahmen usw. des Graphen 
  durch interaktive Dialogboxen.
• Neues Editieren des Farbgradienten: SYSTAT 13 gibt
  Ihnen die präzise Kontrolle über Farbverlauf und Stil 
		der	3D-Graphoberfläche.
• Neue Graphtitelfunktionen: Erstellen Sie numerische
  Beschriftungen in Plots, multivariaten Darstellungen und 
  Landkarten. Beschriften Sie die Punkte in Punktplots.

NOCH MEHR GRAPHEN...

SYSTATs	konfirmatorische	Faktorenanalyse	erleichtert	die	Erstellung	von	Untersuchungen	
und testet die Tauglichkeit von ökonomischen Modellen bzw. von Verhaltens-, Marketing- 
oder Sozialforschungsmodellen.

Prüfen Sie die Tauglichkeit statistischer Modelle mit Hilfe der konfirmatorischen 
Faktorenanalyse

Nutzen Sie die Verbesserungen bereits bestehender statistischer Methoden in 
SYSTAT 13
Arbeiten Sie besser und schneller mit den noch robusteren Test-, Regressions- und Kreuz-
tabellenfunktionen in SYSTAT 13. Zu den Erweiterungen und Verbesserungen gehören u.a.:
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Analysieren Sie größere Datensätze noch schneller
Mit SYSTAT 13 können jetzt noch größere Datensätze als 
zuvor bearbeitet werden. SYSTAT 13 berechnet statistische 
Tests bei den meisten Verfahren bis zu 10 mal schneller als 
ältere Versionen.

Beschleunigen Sie das Scripting und die Dateneingabe 
mit verbessertem Auto-Complete und Token-Dialog
Geben Sie SYSTAT-Skriptbefehle mit den verbesserten 
Auto-Complete-Funktionen leichter ein und vermeiden Sie 
dabei Tippfehler. Sie erhalten automatische Optionen für 
Datei- und Variablennamen und optionelle Werte. Außerdem 
bietet SYSTAT 13 jetzt einen Token-Dialog, der es Ihnen 
ermöglicht, Variablenwert-Optionen während der Daten-

Erleben Sie den verbesserten Look und 
das neue Arbeitsgefühl
SYSTAT 13 bietet einen vollständig neu 
gestalteten Daten-Editor, der Ihnen 
größere	Kontrolle	und	flimmerfreie	Sicht	
gibt. Zudem wurde ein neuer Daten-
navigations-Werkzeugbalken hinzugefügt, 
mit dem Sie schnell zu jedem gewünschten 
Fall	einer	spezifischen	Variablen	springen	
können.	Die	SYSTAT-	Oberfläche	und	die	
Dialogboxen wurden ebenfalls verbessert, 
um Ihre Arbeit mit mit dem Programm 
weiter zu erleichtern.

Die	Auswahl	aus	den	vorkonfigurierten	Themen	in	SYSTAT	ist	jetzt	noch	leichter	als	zuvor.	
SYSTAT 13 listet alle Themen, die zum Download zur Verfügung stehen, auf und versieht 
jedes Thema mit erweiterten Informationen. Wählen Sie aus einer dieser zahlreichen 
Optionen	oder	konfigurieren	Sie	Ihre	individuelle	Darstellung	und	Arbeitsoberfläche.

NOCH WENIGER AUFWAND!

Sichern Sie Ihre Arbeit mit SYSTATs ‘Rettungs’-Report
Der ‘Rettungs’-Report sichert Ihre Daten, Kommandos und Ergebnisse, falls es einmal zu 
einem Systemzusammenbruch oder –neustart kommen sollte. In dem ‚Rettungs’-Report-
Dialog erhalten Sie Optionen zur Wiederherstellung Ihrer letzten Schritte. Darüberhinaus 
werden Ihre Daten, Kommandos und Ausgabedateien automatisch an eine Email angehängt, 
so dass das SYSTAT Support-Team Ihnen schnell helfen kann.

Individualisieren Sie die SYSTAT–Konfiguration und -Menüs mit neuen Themen 
nach Wunsch.

eingabe aus Drop-Down-Menüs zu wählen. SYSTAT 13 gibt Ihnen größere Kontrolle über 
den Dateneingabe-Prozess und reduziert dabei drastisch übliche Eingabefehler.
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Der SigmaCERF-Server ermöglicht das 
zentrale Management von System-
funktionen (z.B. Sicherheit, Anwender- 
und Systemadministration, Arbeits-
abläufe) sowie von Datenspeicherung, 
Projekten, Inhalten, Annotationen, 
Metadaten und der Organisation von 
Experimenten.
Projekte, Dokumente, Daten und Note-
books können überall, wo der Anwender 
einen Internet-Zugang hat, erstellt und 
bearbeitet werden.

SigmaCERF ist ein sicheres wissenschaftliches 
Informationssystem, das speziell für die Verwaltung und 
gemeinsame Nutzung von Inhalten (Dokumente, Tabel-
len, wissenschaftliche Daten, Berichte), Anwendungen 
und Datenbanken in Forschungsorganisationen der multi-
disziplinären Life Sciences entwickelt wurde. Das Pro-
gramm kombiniert ein elektronisches Laborjournal (ELN) 
mit einem System für wissenschaftliche Inhaltsverwaltung, 
einem erweiterbaren Framework für Informations- und 
Datenintegration und einer wissenschaftlich orientierten 
Informatik-Plattform. Einzelnutzern, Arbeits- oder 
Forschungsgruppen, die auf mehrere Standorte oder 
verschiedene Forschungseinheiten verteilt sind, stellt
SigmaCERF so eine einheitliche elektronische Informations- 
und Kommunikationsplattform zur Verfügung.

SigmaCERF erfüllt Regelungen und Bestimmungen 
nach 21 CFR Part 11 (Audit Trails, Zeit-Datums-
markierungen, Sicherheit, Zugangskontrolle, 
Anwenderautorisierung, Versionenverwaltung, digitale 
Signaturen, PDF-Berichte) und läßt sich leicht für 
Verordnungs-Vorgaben	(USPTO,	GLP)	konfigurieren.

Zum Schutz geistigen Eigentums (IP) stellt 
SigmaCERF signierte Dateien für die vollständige 
Aufzeichnung der Entstehungs- und Entwicklungs-
historie von Forschungsdaten und Dokumenten in 
druckfähiger und lesbarer Form in einem Langzeit-
Speicherformat zur Verfügung. 
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SigmaCERF - 
Das elektronische Laborjournal-Framework 
für Wissenschaftler und Organisationen in 
Forschung und Entwicklung
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•  SigmaCERF verbindet ein vollwertiges elektronisches Laborjournal  
  (ELN) mit einem wissenschaftlichen Informationsverwaltungssystem, 
  gemeinsamer Nutzung und Projektorganisation. 

   -  Unterstützt die Organisation und gemeinsame Arbeit an Projekten, 
    Experimenten, Notebooks und Berichten.
   -  Bietet Suchfunktionen im Volltext, in Metadaten und in einer kontrollierten 
    Fachterminologie (controlled vocabulary). 
			 -		Fördert	die	einheitliche	und	effizientere	Nutzung	von	Vorlagen	und	
    Formularen in Protokollen und Datensammlungen.

•  SigmaCERF orientiert sich an wissenschaftlichen Arbeitsweisen, 
  speziell in Biologie und multidisziplinären Life Sciences.  

 - Archiviert Annotationen und wissenschaftliche Interpretationen: 
  dokumentiert den Entdeckungsverlauf. 
 -  Erfüllt Regelungen und Bestimmungen nach 21 CFR Part 11: Audit trails,  
  Zeit-/Datumsmarkierungen, Sicherheit, Zugangskontrolle, Anwender- 
  autorisierung, Versionenverwaltung, digitale Signaturen, PDF-Berichte.
 -  Schützt und verwaltet geistiges Eigentum (IP). 
   -  Der Computer des ‘Wissensarbeiters’: SigmaCERF verknüpft persönliche  
    und Teamaktivitäten mit Inhalten und ist mehr anwender- als datenzentriert.  
 

•  SigmaCERFs Aufbau auf Standards und Ontologien ermöglicht eine 
  leichtere Anpassung wissenschaftlicher Datenmodelle und Vorlagen sowie 
  leichte Erweiterung und umfassende Inhalte: ‘The semantic ELN™’ (ELN = 
Electronic Laboratory Notebook).

•  SigmaCERF ist eine Cross-Plattform-Lösung - gleiche Handhabung  
 auf Windows/Linux/Mac.

•  SigmaCERF bietet anpassungsfähige und flexible Zusatzkomponenten. 

 -  Das SigmaCERF Entwicklungs-Set enthält Ontologie-Manager-Programme  
  für die Erstellung von Formularen, Vorlagen, Arbeitsablaufanalysen, 
  wissenschaftlichen Daten- und Metadaten-Modellen, kontrollierter 
  Terminologie und Datenbankintegration.
  

Was tut SigmaCERF?



 Wissenschaftler:

• SigmaCERF erleichtert den Informations- 
 austausch und die gemeinsame Nutzung  
 von Dokumenten und verbessert so die  
 Produktivität von Forschungsprojekten. 

•  SigmaCERF organisiert Projekte, Daten  
 und Informationen und sorgt für die 
 Einhaltung der organisationsinternen 
 Performance-Standards (SOPs). 

•  SigmaCERF reduziert die Zeit, die 
 Wissenschaftler für die Informations-
 verwaltung, Archivierung und Suche nach  
 Dateien aufbringen müssen, um 35 - 60%.  
 So bleibt mehr Zeit für die eigentliche   
 Forschung und die Entwicklung 
 innovativer Ideen, IP (intellectual property)
  und Entwicklungschancen können 
 schneller erkannt werden.

Unternehmens-/F&E-Management:

•  SigmaCERF verbessert die Produktivität,  
	 	Qualität	und	den	Entscheidungsfindungs-
  prozeß in der F&E-Abteilung, indem es mehr  
  Transparenz über aktuelle Entwicklungen  
  fördert und Projekte zu einem schnelleren  
  Abschluß bringt.

•  SigmaCERF erhöht die Unternehmens-
  Bewertung und die Rendite (ROI) im F&E- 
  Bereich.  

•  SigmaCERF verbessert das Portfolio- und  
  Projektmanagement und fördert die interne  
  und abteilungsübergreifende Kommunikation. 

•  SigmaCERF steuert Planung und 
	 	Entscheidungsfindungsprozesse	im	
  Unternehmen und beschleunigt so die 
  Entwicklung zur Marktreife.

IT-Dienstleistungen/Informatik: 

•  SigmaCERF wird aus dem Netz installiert 
  und upgedated. Das reduziert den Support-  
  Bedarf.
 
•  SigmaCERF ist eine Cross-Plattform-Lösung;  
  das Framework bietet leicht zu handhabende,  
  erweiterbare, offene Systeme, die auf Daten-  
  standards, Ontologien und semantischen   
  Web-Technologien aufgebaut sind.  

•  SigmaCERF läßt sich in bestehende 
  Systeme und Datenstandards integrieren 
  und unterstützt diese??

•  SigmaCERF vermindert die Gesamt-
  betriebskosten zugunsten der F&E  
  IT-Anschaffungen.  

Juristische/Patents-/Dokumentations-
Abteilung: 

• SigmaCERF erleichtert die Einhaltung   
 regulatorischer Vorgaben (21 CFR 11).

• SigmaCERF unterstützt die schnellere   
 regulatorische Vorlage von Dokumenten. 
 
• SigmaCERF vermindert Risiken.

• SigmaCERF erfaßt und schützt geistiges  
 Eigentum (IP). 

Wer profitiert von SigmaCERF? 

- 9 - 



Browsen Sie SigmaCERF, um frühere Arbeiten erneut aufzurufen 
und zu nutzen (durch Zugangskontrolle gefiltert) 

 •  Projekte, Experimente, Journale, Dateien 
 •  Hintergrundinformationen, Datenbank-Referenzen
 

Durchsuchen Sie SigmaCERF nach den Informationen, die Sie 
brauchen (Inhalt und Kontext) 

 •  Titel, Autoren, Metadaten   
 •    Volltext-Suche 
 •  Lokalisierung von Experten und Expertisen 
 •  Nutzung der Ausdrucke aus hierarchisch kontrollierter Terminologie 

Verwalten Sie Web- und Datenbankinhalte
	 •		 Microsoft®	Office/IE	(Internet	Explorer)	-Integration	
 •  Speichern von Internetseiten 
 •  SigmaCERF-Integration mit Datenquellen (Anwendungen, Internetdienste, 
   SQL/XML-Datenbanksysteme) 
 •  Öffentlicher und Drittpartei-Datenzugang/-management

Speichern Sie alle Arten von Daten und vereinfachen Sie die 
Dateneingabe
 •  Arbeiten Sie mit den Daten Ihrer bevorzugten Applikationen (allgemein, 
   wissenschaftlich) 
	 •		 Nutzen	Sie	individuelle	Dateneingabe-Formulare,	die	spezifischen
   Forschungsinhalt-Typen entsprechen, und Annotationen einschließlich 
   kontrollierter wissenschaftlicher Terminologie und optionalen 
   Formularfeldern
 

Verbessern Sie die Qualität und Transparenz Ihrer Forschung
 •  Nutzen Sie Journalvorlagen zur Erstellung von Experimentstrukturen und 
   -inhalten, einschließlich aller Formulare und Dateien, die im Projektverlauf 
   ausgefüllt werden müssen.
 •  Erfassen Sie die rohen und behandelten Daten für die erneute Nutzung und  
   Neu-Analyse durch die Wissenschaftler und erstellen und managen Sie 
   “human-readable” Journalansichten und druckfähige PDF-Wiedergaben von  
   Daten (im Kontext vollständiger Aufzeichnungen und evidence trails) zur 
   Unterstützung der Einhaltung Verordnungs-Vorgaben. 

Wie setzen Wissenschaftler SigmaCERF ein? 

- 10 - 



- 11 - 

SigmaCERF Funktionen:
Zusammenarbeit in einer sicheren Umgebung
SigmaCERF-Projekte und -Journale erlauben einer beliebigen Anzahl von Nutzern den 
gemeinsamen Zugriff auf Daten und deren Nutzung in Echtzeit - soweit sie die geeigneten 
digitalen	Referenzen	für	die	Autorisierung	vorweisen	können.	Intuitive	Oberflächen,	hinter	
denen sich der hohe Entwicklungsstand eines robusten und sicheren Systems verbirgt, 
sichern die einfache Handhabung. Ansichten und Aktionsmenüs werden automatisch 
gefiltert,	um	die	zahlreichen	rollenbasierten	Zugangsrechte,	die	sich	an	den	Mitglied-
schaften in SigmaCERF-Arbeitsgruppen orientieren, zu überprüfen. So haben Anwender 
zwar transparenten Zugang zu autorisierten Inhalten, nicht aber zu gesperrten 
Dokumenten und Aktivitäten. 

Versionskontrolle 
SigmaCERFs umfassendes Dokumenten-Kontrollsystem erleichtert das Nachverfolgen 
von Informationen bei gleichzeitiger Befolgung der Anforderungen nach 21 CFR 11. 
Inhalte können in SigmaCERF unter Versionskontrolle gesetzt werden, so dass das 
Überschreiben durch neue Inhalte bei der gemeinsamen Nutzung von Dokumenten 
verhindert wird. Alle Versionen werden aufgezeichnet und bewahrt - jede mit ihren 
eigenen Metadaten - und Anwender können frühere Versionen nach Bedarf ansehen und 
öffnen. Die Versionshistorie enthält das Protokoll der Mitarbeiter, Updates, Kenn-
zeichnungen und Ressourcen-Informationen. Strenge Zugangskontrollen vermeiden das 
versehentliche Verändern von Labor-Standardprozeduren (SOP = Standard of 
Performance) bei der Änderung persönlicher Protokolle und Vorlagen. 

Metadaten 
SigmaCERF extrahiert automatisch grundlegende Metadaten aus jedem Dokument, das 
in der SigmaCERF Datenbank registriert wird. Metadaten helfen bei der Konstruktion von 
Audit Trails und enthalten Angaben zu dem Mitarbeiter, dem Erstellungsdatum und dem 
Ressource-Typ sowie zum letzten Update. Anwender können Formulare nutzen, um 
weitere	Metadaten	wie	Autoren,	Kommentare	oder	Definitionen	hinzuzufügen,	und	sie	
können die Dublin Core Metadaten-Sets, individuelle wissenschaftliche Datenmodelle 
und veränderbare kontrollierte Terminologien benutzen, um Ressourcen noch effektiver 
zu durchsuchen bzw. zu annotieren. SigmaCERF unterstützt Batch-Zusätze des Inhalts 
und	der	Metadaten	sowie	der	konfigurierbaren	automatischen	Datenverarbeitung	für	ver-
schiedene Objekttypen.

Ontologien
Aktionen werden in SigmaCERF	durch	OWL-Ontologien	definiert,	die	kontrollieren,	was	
ein Anwender mit einem bestimmten Ressourcen-Typ tun kann. Wenn zum Beispiel ein 
Anwender dem System eine JPEG-Bilddatei hinzufügt, weiß SigmaCERF, daß der Nutzer 
diese Ressource mit Hilfe eines Graphik-Viewers verändern kann. Wenn der Anwender 
spezifiziert,daß	es	sich	bei	der	JPEG-Datei	um	ein	biomedizinisches	Bild	handelt,	gibt	
SigmaCERF dem Anwender ggfs. einen völlig anderen Funktionensatz als für ein 
Standardbild - das Metadaten-Formular wird kontrollierte Terminologie enthalten, die 
spezifisch	für	biomedizinische	Bilder	ist,	und	das	Bild	kann	mit	einem	spezifischen,	
anstatt mit dem üblichen allgemeinen Bildbetrachtungsprogramm (z.B. Gelanalyse-
Software) geöffnet werden. Spezielle Ontologien können für praktisch jeden Nutzer, jede 
Ressource und Situation und für jeden Arbeitsablauf erstellt werden und können Skripts 
für die Automation und den Datenverarbeitungsprozeß enthalten. 



Formulare und Vorlagen 
Ein großer Teil der Forschung entfällt auf das Aufzeichnen von Daten und diese Aufgabe 
kann viele Mitarbeiter im Unternehmen involvieren. Vorlagen dienen der Standardisierung 
von	Prozeduren	und	der	Verbesserung	der	Genauigkeit	und	Effizienz	der	Dateneingabe.	
Wie alle Ressourcen in SigmaCERF haben Vorlagen damit verbundene Metadaten, die 
eine komplette Audit-Historie und zusätzliche Suchmöglichkeiten bieten. Vorlagen und 
Formulare können leicht an Ihre individuellen Bedürfnisse angepaßt werden - entweder 
durch uns, durch Ihren SigmaCERF-Administrator oder durch Power User.

Kontrollierte Terminologie
Statt der Eingabe von Annotationen durch das Eintippen von Wortfolgen bietet 
SigmaCERF kontrolliertes Vokabular, das es dem Anwender ermöglicht, die geeigneten 
Metadaten-Kategorien	und	Schlüsselworte	aus	vordefinierten	Listen	(flach	oder	
hierarchisch	geordnet)	zu	wählen.	Diese	kontrollierte	Terminologie	kann	konfiguriert	und	
verändert werden, so daß Sie entsprechend den verschiedenen Ressourcen-Typen auch 
verschiedene Sätze an kontrolliertem Vokabular haben können. So wird eine einheitliche 
Schreibweise im Unternehmen etabliert und relevante Inhalte können problemlos 
gefunden werden

Digitale Signaturen
Jedes Dokument, jeder Datensatz oder jede Journalseite in SigmaCERF kann durch den 
Ressourcen-Mitarbeiter und einen oder mehrere Mitunterzeichner (je nach dem vorher 
bestimmten	Arbeitsablauf)	digital	signiert	werden.	Dies	ermöglicht	die	Authentifizierung	
und	Verifizierung	des	Dokumentenursprungs	und	-inhalts	und	es	enthält	eine	Zeit-/
Datums-Markierung sowie Kommentare des Unterzeichnenden. SigmaCERF generiert 
einzigartige	Kryptifizierungs-Schlüsselpaare	für	jeden	Anwender	und	erlaubt	es	ihm,	dem	
signierten Dokument eingescannte Bilder seiner handgeschriebenen Unterschrift 
hinzuzufügen.	Journalseiten	ermöglichen	einen	konfigurierbaren	Signatur-Arbeitsablauf,	
in	dem	Mitunterzeichner	mit	spezifischen	Signierrollen	die	Ressource	in	einer	bestimmten	
Ordnung signieren müssen - alles von SigmaCERF im Hintergrund organisiert.

Microsoft Office Integration 
SigmaCERF	wird	mit	einem	optischen	Microsoft	Office®	Integrationspaket	geliefert,	
welches	das	Speichern	von	Microsoft	Office-Dokumenten	in	einem	SigmaCERF-Journal	
erleichtert.	Nach	Ablauf	der	Installation	verzeichnet	die	Microsoft	Office-Anwendung	einen	
neuen “Export to Local SigmaCERF”- (“In lokales SigmaCERF exportieren”) Button.
Das	Microsoft	Office-Integrationspaket	enthält	eine	“Select	‘n	Search”-	(“Wählen	und	
Durchsuchen”)-Option, die es Anwendern ermöglicht, mehrere Datenbanken mit Such-
worten zu durchsuchen, die durch Hervorheben von Text gekennzeichnet sind. Die Ergeb-
nisse der Suche werden dann in SigmaCERF gespeichert.

Optionale Integration mit Amphora PatentSafe™ 
Das SigmaCERF-Notebook™ läßt sich mit dem Amphora PatentSafe™ System 
integrieren. Das sichert direkten Zugriff auf die sicheren elektronischen Aufzeichnungen 
in ihrem Originalformat im ELN-System, und sichere Ausdrucke der Aufzeichnungen auf 
dem Amphora PatentPad Sicherheitspapier.
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ABSTRACT  
 
Techniques using digital image analysis have been recently developed to 
evaluate turfgrass stands for percent green cover and average color. Manually 
analyzing	digital	images	may	become	cumbersome	and	tedious	if	turf	field	trials	
contain many plots or if images are collected at frequent intervals for analysis. The 
objective of the following work was to develop a user-friendly macro capable of 
automated batch analysis of an unlimited number of digital images. A macro named 
“Turf Analysis” was written to batch analyze images using SigmaScan Pro software. 
The macro, which requires less than 1 min of manual execution, performs percent 
cover and/or color analysis on an unlimited number of images and automatically 
saves	the	results	into	a	spreadsheet	file.	The	macro	is	freely	available	to	download.

INTRODUCTION  
 
HISTORICALLY,	field	experiments	investigating	turfgrass	have	been	evaluated	by	
visual	ratings.	Although	relevant	information	may	result	from	such	evaluations,	final	
inferences may be questionable because of the subjective nature in which the data 
were collected (Horst et al., 1984). Recently, digital image analysis techniques have 
been developed that allow researchers to objectively measure turfgrass 
characteristics such as percent ground cover (Richardson et al., 2001) and turf color 
(Karcher and Richardson, 2003). The analysis techniques utilize SigmaScan Pro 
software (SPSS, 1998) to select pixels representing turf within an image so that they 
may be further processed for the evaluation of interest. The ground cover techniques 
allow researchers to accurately measure parameters such as establishment rates, 
disease incidence, and recovery from injury or dormancy. The color methods allow for 
comparison of genetic color among varieties, as well as responses to fertility or other 
management variables. 

Under normal use of SigmaScan Pro, each image must be processed manually, 
which may take several minutes and limit large-scale use of the techniques. However, 
SigmaScan Pro is enabled with a macro language so that users may automate soft-
ware processes. The development of a user-friendly, easily attainable macro to batch 
analyze large numbers of turf images should broaden the use of digital image 
analysis techniques and result in more objective evaluations of turfgrass trials. The 
objective of the following work was to develop such a macro. - 13 - 



MATERIALS AND METHODS  
 
A SigmaScan Pro macro named “Turf Analysis” was written by the authors (in visual 
basic for applications language) that is capable of batch analyzing turf images. The 
macro may be freely downloaded from the University of Arkansas web site: http://
www.uark.edu/campus-resources/turf/turfmacro;	verified	11	March	2005.	SigmaScan	
Pro must be installed on the same PC containing the macro for proper operation. 

Before	executing	the	macro,	the	images	to	be	analyzed	must	all	share	the	same	file	
extension and be named so that they share a root name and each image contains a 
unique,	consecutive	number	at	the	end	of	the	file	name	(example:	Plot01.jpg,	Plot02.
jpg, Plot03.jpg...). Most digital image archiving software packages that are sold with 
digital	cameras	are	capable	of	naming	or	renaming	image	files	similar	to	the	format	
described	above.	In	addition,	there	are	many	freeware	file	renaming	software	
packages currently available for download (Nonags.com, 2004). The macro will 
function	correctly	with	or	without	leading	zeros	at	the	end	of	the	file	name	and	with	
any	image	file	extension	that	SigmaScan	Pro	recognizes	(.jpg,.bmp,.tif,	etc...).	

The macro is executed by selecting “File > Open > Macro” from within SimgaScan 
Pro.	Upon	selecting	the	“Turf	Analysis”	macro	file	and	then	pressing	the	“F8”	key	to	
begin macro execution, a dialog box named “Turf Analysis Settings” is opened (Fig. 
1)	to	customize	the	macro	settings	for	a	specific	analysis	of	a	batch	of	images.	

 

 

Color Analysis

An analysis of turf color will be performed on the images if the “Perform color 
analysis” (Fig. 1) checkbox is selected. Either entire images may be used to 
determine average color or a color threshold may be used to determine average color 
from selected pixels. In the example analysis settings, color analysis of the brown 

Fig. 1. User dialog box used to adjust the image 
analysis settings before executing the “Turf Analysis” 
macro.

Image Files Information

The parent folder, shared root name of 
the	images,	image	file	extension,	and	
the	first	and	last	file	numbers	are	
defined	within	the	“Image	Files	
Information”	box.	If	the	image	files	
contain leading zeros, these should be 
included	in	the	text	boxes	defining	the	
first	and	final	image	numbers.	In	the	
example analysis settings shown in Fig. 
1, a batch of 489 images of tall fescue 
(Festuca arundinacea L.) plots diseased 
with brown patch (Rhizoctonia solani 
Kühn)	is	to	be	analyzed.	The	files	are	
named “Plot001.jpg” through Plot489.
jpg” and are located in the folder, “C:\
Documents and Settings\KARCHER\My 
Documents\Research\NTEP Tall 
Fescue\Brown Patch Images.” 

- 14 - 
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patch images will be performed using threshold settings so that only green pixels 
(representing nondiseased turf) are used to calculate average color. The default 
macro settings perform a color analysis using the entire image to calculate average 
color. 

Cover Analysis
An analysis of percent turf cover will be performed on the images if the “Perform 
cover analysis” (Fig. 1) checkbox is selected. Three options are available for 
determining the total number of pixels in each image, which is subsequently used 
to	calculate	percent	cover:	The	first	option	is	to	separately	measure	the	total	pixel	
number for each image, which is the slowest option, but is necessary if total pixel 
numbers vary among the images within a batch. This would be the case if pictures 
within a batch were taken with different resolution settings or if images were cropped 
before analysis. The second option is to only measure the total pixel number for the 
first	image	and	use	that	value	as	the	total	pixel	number	for	all	subsequent	images,	
which is appropriate if all images within an analysis batch were taken with identical 
camera settings, not cropped, and thus share the same number of total pixels. The 
third and fastest option, which may be used if all images share the same number of 
total pixels, is to manually enter the shared total pixel number in the text box 
provided. The default macro settings analyze images for percent cover and only 
measure	the	first	image	to	determine	total	pixel	numbers.	

Threshold Settings
The “Threshold Settings” box (Fig. 1) is used to adjust the hue and saturation levels 
that are used to select pixels representing green turf for the cover and color analyses. 
Before executing the macro, it is important to open a few representative images in 
SigmaScan Pro and select “Image > Threshold > Color Threshold” to determine the 
precise hue and saturation levels that will select the pixels of interest within the 
images. The appropriate threshold settings will vary depending on factors such as 
turf species and variety, management practices, light conditions present when 
images were collected, and camera model and settings. The default settings are hue 
levels from 30 to 100 and saturation levels from 0 to 100. 

If	the	“Save	output	as	Excel	file	in	image	folder”	box	(Fig.	1)	is	checked,	the	macro	
output will be automatically saved to the folder containing the batch of images to be 
analyzed.	The	default	macro	setting	is	to	save	the	output	as	a	Microsoft	Excel	file.	
Clicking the “OK” button will begin the image analysis process. 

RESULTS AND DISCUSSION  
 
The results from analyzing the batch of 489 brown patch images from executing the 
“Turf Analysis” macro are shown in Fig. 2. The spreadsheet is automatically saved as 
“Turf Analysis [DATETIME STAMP]” and in this example, the spreadsheet was saved 
on 17 Sept. 2004 at 2058 h and 45 s. The spreadsheet was saved in, “C:\Documents 
and Settings\KARCHER\My Documents\Research\NTEP Tall Fescue\Brown Patch 
Images,” the same folder containing the analyzed images. 
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Columns E through J contain the average color information from either the entire 
image or the selected pixels, depending on the macro settings. In this example, only 
the selected pixels representing green turf were used to determine average color 
(Fig. 1). From the macro output, average turf color may be described using either the 
red/green/blue or hue/saturation/brightness color model (Karcher and Richardson, 
2003). 

The example analysis accomplished with the “Turf Analysis” macro, which evaluated 
489 images for percent turf cover and turf color, required less than one minute of 
manual execution. At an average rate of three minutes per image to manually evalu-
ate percent cover and color in SigmaScan Pro, the “Turf Analysis” macro saved more 
than 24 h of manual, tedious labor. Although the macro can be executed in less than 
one minute, the analysis will complete at a rate from <5 s to 1 min. per image, de-
pending on the resolution of the images and the computer processing speed. 

Although the “Turf Analysis” macro was developed for the analysis of turf images, its 
utility may be extended to analyze virtually any plant species. Through collaboration 
efforts with colleagues from the departments of Horticulture and Crop, Soil, and En-
vironmental Sciences at the University of Arkansas, Fayetteville, the macro has been 
tested successfully in quantifying the colors of poinsettia (Euphorbia pulcherrima 
Willd.)	and	petunia	(Petunia	spp.	Juss.)	flowers,	spinach	leaves	(Spinacia	oleracea	
L.) and quantifying soybean [Glycine max (L.) Merr.] canopy coverage. 
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Fig. 2. Spreadsheet containing output following 
the execution of the “Turfgrass Analysis” macro 
using the settings as shown in Fig. 1.

Column	A	contains	the	file	path	information	
of each image analyzed. Column B contains 
the total pixels of each image analyzed and 
in this example all of the images contained 
307200 pixels (camera resolution was 
set to 640 x 480). Column C contains the 
number of pixels representing green turf as 
determined from the threshold settings. In 
this	example,	the	first	three	images	have	
232093, 190246, and 202479 green turf 
pixels, respectively. Column D contains the 
calculated percent turf cover as the 
quotient of selected pixels to total pixels. In 
this	example,	the	first	three	images	have	
75.6, 61.9, and 65.9% green turf cover, 
respectively.



Systat Software Online-Seminare:
 
Lernen Sie in nur 30 Minuten direkt an Ihrem PC, wie Sie mit wenigen Klicks Ihre 
Forschungsdaten analysieren und publikationsfähige Graphen erstellen. Für unsere 
kostenlosen Online-Seminare benötigen Sie nur einen Internet- und Telefon-
anschluss. Die nächsten Termine für das Online-Seminar “SigmaPlot 11 - Mit 
wenigen Klicks von Daten zur Präsentation”, sind:

                                 Mittwoch, 20. Januar 2010, 14 Uhr 

Melden Sie sich gleich online auf www.systat.de	an.	Hier	finden	Sie	auch	noch	
weitere Informationen. Oder rufen Sie uns unter 02104 9540 an, wenn Sie noch 
Fragen haben.

Veranstaltungen

Tech Tipp
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Festlegung der Fehlerbalken-Richtung in Plots mit 
mehreren Kurven
SigmaPlot bietet die Möglichkeit, bei mehreren Kurven innerhalb eines Graphs die 
Richtung der Fehlerbalken (error bars) einzeln zu bestimmen.

Grundsätzlich kann man in den Graph Properties (im Hauptmenü ‘Graph’ oder durch 
Doppelklick auf den Graphen) die Richtung der Fehlerbalken eines Plots angeben. 
Um die Richtung nun separat für jede Kurve anzugeben, sollte der Graph statt als 
‘multiple scatter/line” als Kombination einzelner “single scatter/line”-Plots angelegt 
werden:

1. Erzeugen Sie nun den ersten Plot: “Line and Scatter Plot > Simple Error Bars”.
2. Markieren Sie diesen Plot nun per Mausklick und wählen dann aus dem Haupt-
menü ‘Graph’ die Option ‘Add Plot’. Fügen Sie einen weiteren “Simple Error Bars”-
Plot (für die zweite Kurve) hinzu.
3. Wiederholen Sie den zweiten Schritt für die anderen Plots.

Nun können Sie in den ‘Graph Properties’ für jeden Plot separat die Fehlerbalken 
ändern. Im ‘Plots’-Tab unter “Plot” können Sie dabei zwischen den Plots umschalten, 
ohne das Dialogfenster verlassen zu müssen.
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Um Überlagerungen bei der Fehlerbalkenrichtung zu vermeiden, können Sie für 
einen “single scatter”-Plot die Fehlerbalkenrichtung auch für jeden einzelnen Punkt 
bestimmen:

1. Geben Sie in einer leeren Spalte des Arbeitsblatts je Punkt einen der Buchstaben 
p, n oder b (für “positive”, “negative” oder “both”) ein.
2. Wählen Sie diese Spalte dann in der “Error Bars” > ‘Direction’-Liste der “Graph 
Properties” als Option aus (s. hierzu auch “Customizing Error Bar Direction” in der 
Online-Hilfe).

Fig. 1
Die Richtungen der Fehlerbalken wurden aus Spalte 
9-12 übernommen (positiv/negativ, individuell fest-
gelegt pro Punkt im Plot).

Zur besseren Unterscheidung wurden außerdem für 
Plot 1 und 4 die Fehlerbalken-Köpfe verbreitert.
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Graphen und Objekte bewegen mit der “Nudging”-
Funktion
Man kann Graphen und Objekte auf der Graphseite mit den Pfeiltasten der Tastatur 
bewegen: 

Selektieren Sie mit Hilfe der Maus das gewünschte Objekt und bewegen Sie es nun 
mit den Pfeiltasten.
 
Objekte können durch Drücken der ‘Tab’-Taste selektiert werden. Das Drücken von 
‘Shift+Tab’ blättert durch die Folge der Objekte zurück, mit ‘Shift+Pfeil’ werden 
mehrere Objekte selektiert. 
 
Jedes Drücken der Pfeiltaste bewegt den Graph oder das Objekt um einen Punkt 
oder 0.014 inch. Diese Voreinstellung können Sie in der spw.ini-Datei ändern. Wenn 
Sie die Option “Snap-to-grids” (= “am Gitternetz ausrichten”; siehe Tools > Options > 
Page) aktiviert haben, kann die ‘Nudge’-Funktion nur greifen, wenn der ‘Nudge’-Wert 
höher oder gleich dem ‘Snap-to’-Wert ist.

Objekte, die berechnet werden, wie Plots und alle Bereiche eines Plots, Teilstriche 
und Regressions- sowie Referenz- und Gitternetzlinien können nicht mit der ‘Nudge’-
Funktion bewegt werden.

Tech Tipp


